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1 INTRODUCTION 

The uPASS Target reader offers long range (up to 10 meters / 33 feet) identification 

using the latest UHF technology. Based on passive (battery free) UHF tags the uPASS 

Target offers a cost effective and enduring solution for long range identification. 

 

The uPASS Target reader can be placed near the entrance, door or gate on poles or 

on the wall with help of the mounting brackets. 

 

The uPASS Target includes a RS-485/RS-422, Wiegand/Magstripe, Nedap antenna, 

TCP/IP and a relay interface. With these interfaces the uPASS Target can be 

connected to an Access Control System for authorization. The relay interface can be 

used for operating external device (for example doors and gates) based on UHF tag 

recognition or external control. 

 

The uPASS Target has 3 digital inputs. With these inputs color of the LED, activation 

of the relay and the activation of the UHF reader can be controlled. 

  

The uPASS Target reader features a TRANSIT compatible mode. In this mode the 

reader is fully compatible with the Nedap TRANSIT, supporting any firmware version 

developed for the TRANSIT reader, for example P61, P81 and Q70. See chapter 4 for 

details how to enable the TRANSIT compatible mode. 

 

1.1 SUPPORTED TAGS 
Any EPC Class 1 Gen 2 tag is supported by the uPASS Target and will output on the 

RS-422, RS-485 or Ethernet interfaces. Also special formatted Nedap UHF tags are 

supported for output on special interfaces. The following formats are supported: 

 

Nedap UHF Wiegand tags 

These tags will contain all Wiegand information including facility code and parity 

bits. All Wiegand formats can be supported. The reader transparently sends this 

information via the Wiegand outputs. There is no need to change any DIP-switches 

or configuration settings. See chapter 3.2.2 for wiring details. 

 

Nedap UHF Magstripe tags 

These tags will contain all Magstripe information. The reader transparently sends this 

information onto the Magstripe interface. There is no need to change any DIP-

switches or configuration settings. See chapter 3.2.2 for wiring details.  

 

Nedap UHF XS tags 

These tags are especially programmed in the same format as our 2.45GHz TRANSIT 

tags (Compact-Tag, Window-Button and Heavy-Duty-Tag). The tags will also have a 

customer-code and id-number. The reader will modulate the tag-info onto the 

Nedap antenna interface output, which can be connected to Nedap AEOS access 

control hardware such as the AP1001. These UHF tags will also work in TRANSIT 

compatible mode.  
  

Note 

The Wiegand output format 

is determined by the tag 

and not by the reader. 

Note 

The Magstripe output 

format is determined by the 

tag and not by the reader. 

Note 

See also the 'decode Nedap 

XS' feature as described in 

chapter 6.3.3. 
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1.2 TAG SECURITY 
EPC (Electronic Product Code) tags were introduced as a possible successor to the 

barcode with added functionalities. The tag emits its EPC in plain text. This makes 

the tags vulnerable to cloning and counterfeiting attacks. Unlike many 13MHz 

smartcards, EPC tags do not support any DES, 3DES or AES encryption. 

 

EPC tags contain a data field known as the Tag Identifier (TID). At the discretion of 

the EPC manufacturer, the value may be factory programmed and locked, ensuring 

that tags have a unique identity and (theoretically) cannot be cross-copied. This TID 

based anti-cloning mechanism is not considered to be a strong protection. 

 

Nedap UHF tags support a locked serialized TID and the uPASS Target reader can be 

configured to read the TID data field and send its data to the Access Control System 

for verification. 

 

By default the uPASS Target reader is configured to read any EPC tag. 

 

We encourage customers to enable the TID-check. But also advise not to completely 

rely on this methods in high-security applications. 

 

Tag security is not evaluated by UL. 
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2 INSTALLATION 

2.1 SAFETY INSTRUCTIONS 
The following safety precautions shall be observed during normal use, service and 

repair. 

 

 The uPASS Target shall only be installed and serviced by qualified service 

personnel. 

 Disconnect the power supply before (dis)connecting any wires, uPASS 

Target is NOT hot-swappable, so when making or changing connections, 

power must be switched OFF. 

 To be sure of safety, do not modify or add anything to the uPASS Target 

other than mentioned in this installation guide or indicated by Nedap N.V. 

 

2.2 MOUNTING INSTRUCTIONS 
The uPASS Target can be mounted to any surface with the wall mounting bracket and 

Pole Mounting Set (see appendix B for part numbers). The uPASS Target can be 

“aimed” at the desired detection area with the mounting brackets. 

 

2.2.1 READER DIMENSIONS 
The dimensions of the uPASS Target reader can be seen in Figure 1. 

 

 

Figure 1: uPASS Target dimensions 
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2.2.2 WALL MOUNTING BRACKET 
The Wall Mounting Bracket is supplied with the uPASS Target reader. When the Wall 

Mounting Bracket is assembled mount it to the wall (or the Pole Mounting Set) based 

on the dimension in Figure 2. The uPASS Target can be “aimed” with the Wall 

Mounting Bracket and when the bolts are tightened it will stay in place.  

 

 

Figure 2: Wall Mounting Bracket 
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2.2.3 POLE MOUNTING SET 
The Pole Mounting Set has to be ordered separately (see appendix B). 

The uPASS Target can be mounted to round poles with maximum diameter of 190 

mm / 7.48 inches and square poles with maximum diameter of 150 mm / 5.90 

inches using the Pole Mounting Set. The Wall Mounting Bracket is mounted on the 

Pole Mounting Set. 

 

 

Figure 3: Pole Mounting Set 
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2.2.4 WEATHER PROTECTION HOOD MOUNTING 
After the mounting of the uPASS Target an optional weather protection hood can be 

placed. The weather protection hood protects the uPASS Target from excess heat 

caused by sun irradiation. It is advised to install the weather protection hood if the 

ambient temperatures are 40°C (104°F) or higher and more than 2 hours of direct 

sunlight on the uPASS Target housing. 

 

The weather hood can be placed over an already mounted uPASS Target (some bolts 

need to be loosened). It is recommended that the connections to uPASS Target are 

made before mounting the weather protection hood. If the weather protection hood 

is mounted the connectors are hard to reach. 

 

The weather protection hood has to be ordered separately (see appendix B). 

 

 

Figure 4: Weather Protection Hood 



UPASS TARGET | INSTALLATION GUIDE 
Connections 

 9/36 

3 CONNECTIONS 

The uPASS Target has 7 connectors at the bottom of the device (see Figure 5). CONN. 

2, CONN. 3 and CONN. 5 are shielded connectors. All connectors shown in this 

chapter are seen from the outside. All connectors for the cables are supplied (except 

mini USB and TNC (Ext. Ant.)). 

 

The connection aren’t secured and the communication isn’t encrypted. If safety is 

paramount it is recommended to place the connectors and cables so they cannot be 

accessed outside the security zone. 

 

 

Figure 5: uPASS Target connectors 

 

Figure 6 shows a simplified schematic overview for most of the uPASS Target 

connections. This figure shows the overview when the reader is in normal UHF (not 

TRANSIT compatible) mode determined by SW1-1 (see chapter 4).  

 

3 Points (A, B and C) control the direction of the serial interface to USB, RS-422, RS-

485 or one Ethernet channel (the other is fixed to the UHF processor): 

A. When the USB cable is connected, the USB interface is used 

B. The “main comm. interface” setting (see chapter 6.4.1) determines the use 

of Ethernet or RS-422/RS-485 

C. Determined by SW1-2 (located near the USB port) RS-422 or RS-485 is 

used 

 

 

Figure 6: Schematic overview UHF mode 
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Figure 7 shows a simplified schematic overview for most of the uPASS Target 

connections. This figure shows the overview of the reader in TRANSIT compatible 

mode determined by SW1-1 (see chapter 4).  

 

Also in TRANSIT compatible mode there are three points (A, B and C) that control the 

direction of the serial interface to USB, RS-422, RS-485 or one Ethernet channel (the 

other is fixed to the UHF processor): 

A. When the USB cable is connected, the USB interface is used 

B. The “main comm. interface” setting (see chapter 6.4.1) determines the use 

of Ethernet or RS-422/RS-485 

C. Determined by SW1-2 (located near the USB port) RS-422 or RS-485 is 

used 

 

 

Figure 7: Schematic overview TRANSIT mode 
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3.1 POWER SUPPLY 
The uPASS Target requires an external power supply. It is possible to power the 

uPASS Target by connecting a DC power supply. Another possibility is to power the 

uPASS Target by Power over Ethernet (PoE).  

 

If both are connected, the power source depends on the DC power supply voltage. 

The DC power supply is used if its voltage is higher than 13.6V. Otherwise the Power 

of Ethernet is used  

 

DC power supply 

A DC power supply can be connected to the uPASS Target via CONN. 5. This DC 

power supply must be able to deliver 12Vdc/1.5A or 24Vdc/0.75A. 

 

 

Figure 8: CONN. 5 

Pin Function 

1 - 

2 Ground 

3 DC+ 

4 - 

Table 1: Power supply connection 

 

Power over Ethernet 

Power over Ethernet operates over Ethernet cables. CONN. 4 is a RJ45 Ethernet 

connection and can be used for Power over Ethernet. The uPASS Target requires 

IEEE802.3at (Power over Ethernet Plus). 
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3.2 COMMUNICATION 
3.2.1 RS-422 / RS-485 
The RS-422 and RS-485 interfaces are located in the unshielded CONN. 1. The RS-

422 or RS-485 communication can be used for communication with the Access 

Control System, configuration settings and firmware update.  

 

Only the RS-422 or the RS-485 interface can be active (not both), this is determined 

by SW1-2 (located near the USB port). If SW1-2 is switched OFF, the RS-485 

interface is used. Otherwise the RS-422 interface is used. For the RS-422 / RS-485 to 

work, no USB should be connected and the “main comm. interface” must be set 

correctly (see chapter 6.4.1).  

 

The maximum cable length for both interfaces is 65 meters / 213 feet. This distance 

can be increased1 by adding termination resistors, using twisted cables and/or 

configuring a lower baud rate (see chapter 6.3.1). 

 

The communication protocol used for the RS-422 and RS-485 can be found in the 

uPASS firmware guide. It isn’t possible to use the communication protocol in a bus, 

only point-to-point communication is possible. The default communication settings 

are 115200 Baud, 8 data bits, 1 stop bit and no parity. 

 

By default the serial interface is connected to the UHF processor but can be 

connected to the TRANSIT compatible processor, see chapter 4.  

 

 

Figure 9: CONN. 1 

Pin Function RS-4222 Function RS-485 

1 TX- - 

2 TX+ - 

3 RX- B 

4 RX+ A 

5 Ground Ground 

Table 2: RS-422 and RS-485 connection 

 

 

  

                                                                    
1  RS-422 can reach 1500 meters / 4900 feet at 90000 Baud 
 RS-485 can reach 1200 meters / 4000 feet at 8333 Baud 
2  TX (transmit) is the uPASS Target transmit line. 
 RX (receive) is the uPASS Target receive line. 
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3.2.2 WIEGAND / MAGSTRIPE 
The Wiegand and Magstripe interfaces are located in shielded CONN. 2. The 

Wiegand and Magstripe communication can be used for communication with to 

Access Control System only.  

 

The Wiegand and Magstripe can operate with a cable length of 150 meters / 490 

feet. 

 

By default the interface is connected to the UHF processor but can be connected to 

the TRANSIT compatible processor, see chapter 4.  

 

If connected to the UHF processor, Nedap UHF Wiegand tags generate a Wiegand 

message on the interface and Nedap UHF Magstripe tags generate a Magstripe 

message on the interface. 

Other UHF tags do not generate a message on this interface, unless the 'Extra output' 

settings are used. (See chapter 6.4.3) 

 

The Wiegand/Magstripe output format is determined by the programmed format of 

the tag. Make sure to order the correct tag programming format if you want to use 

the Wiegand or Magstripe interface. See UHF How To Order Guide for more 

information about ordering the UHF tags. Refer to the uPASS firmware guide for 

details over the Wiegand/Magstripe timing. 

 

In case the TRANSIT compatible processor is selected, the same connections are 

used. Remember that in this case the tags must be programmed in the Nedap UHF 

XS format. Refer to the corresponding TRANSIT firmware guide for protocol details. 

 

 

Figure 10: CONN. 2 

Pin Function Wiegand Function Magstripe 

1 - - 

2 Data 0 Clock 

3 - Card loaded 

4 Data 1 Data 

5 - - 

6 Ground Ground 

7 Ground Ground 

8 - - 

Table 3: Wiegand and Magstripe connection 
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3.2.3 ETHERNET 
An Ethernet connection is located in CONN. 4. The Ethernet interface can be used for 

communication with the Access Control System, configuration and firmware update 

up to a distance of 100 meters / 328 feet. 

 

The uPASS Target is equipped with two TCP/IP Channels. Channel 1 (default 10001) 

is connected to UHF processor or TRANSIT compatible processor. Channel 2 (default 

10002) is always connected to the UHF processor with a baud rate of 115200. 

 

The reader automatically gets an IP address from a DHCP server. The IP address 

assigned can be found based on the MAC address of the uPASS Target (located on 

the sticker). An example if the tool Lantronics Device Installer 

 

The Ethernet module can be configured to have a static IP address. This can be done 

by the web interface:  

 Open the browser and go to the IP address of the reader 

 Fill in the username and password (by default both blank) 

 Open “Network” and select “Use the following IP configuration:” 

 Fill in the required fields  

 Click OK and Apply Settings 

 

The communication protocol used for the Ethernet is the same as for RS-422 and can 

be found in the firmware guide. If the baud rate of the reader is changed the 

Ethernet setting for Channel 1 must change. This can be done by the web interface: 

 Open the browser and go to the readers IP address 

 Fill in the username and password (by default both blank) 

 Open “Channel 1” - “Serial Settings”  

 Check if the “Port Settings” match the reader serials settings (as for USB or RS-

422/RS-485) 

  Click OK and Apply Settings 

 

By default channel 1 is not connected. To connect channel 1, the “main comm. 

interface” (chapter 6.4.1) needs to be set to TCP/IP. It is also possible to connect to 

the TRANSIT compatible processor, see chapter 4. Make sure the serial settings of 

the Ethernet configuration match the setting of the TRANSIT compatible processor. 

 

 

Figure 11: CONN. 4 
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3.2.4 USB 
The uPASS Target reader features a mini USB interface for service, installation and 

firmware upgrade purposes. The USB interface creates a virtual COM port that can be 

used the same way as a normal (serial) COM port. 

 

The communication protocol for the USB can be found in the firmware guide. The 

default communication settings are 115200 Baud, 8 data bits, 1 stop bit and no 

parity. 

 

By default the interface is connected to the UHF processor, but can be connected to 

the TRANSIT compatible processor, see chapter 4. 

 

 

Figure 12: Mini USB interface (with SW1) 

 

USB Driver installation 

Make sure your computer is connected to the internet. The driver should install 

automatically via Windows update when the uPASS Target reader is connected to 

your PC via the USB cable. Follow the driver installation wizard. If you do not see the 

Windows update pop-up, you can manually install the driver. To manually install, 

you need to go to FTDI’s website at www.ftdichip.com/Drivers/VCP.htm and 

download the VCP (Virtual Com Port) drivers for your operating system. Drivers for 

OS X and Linux are available as well. 
  

http://www.ftdichip.com/Drivers/VCP.htm
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3.2.5 NEDAP ANTENNA INTERFACE 
The Nedap antenna interface is used to connect the uPASS Target to Nedap AEOS 

access control hardware such as the AP1001. The uPASS reader simulates a 120 kHz 

Nedap proximity card to the AP1001. This only works with Nedap-XS and EM4102 

formatted UHF tags. 

 

The uPASS Target can replace the 120 kHz antenna. The “HF Data” must be 

connected to the “ANT” connection and the “Ground” to “GND” (see Figure 13). 

 

 

Figure 13: Replacement of 120 kHz antenna 

 

 Another possibility is to leave the 120 kHz in place and connect the uPASS Target. 

That way 120 kHz and uPASS Target both can be used (see Figure 14). 

 

 

Figure 14: Addition to 120 kHz antenna 

 

The Nedap antenna interface is located at CONN. 3. 

 

 

Figure 15: CONN. 3 

Pin Function 

1 - 

2 HF Data 

3 - 

4 - 

5 Ground 

Table 4: Nedap antenna connection 
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3.3 DIGITAL I/O 
3.3.1 GENERAL PURPOSE INPUTS / LED AND RELAY CONTROL 
Two general purpose inputs are located in CONN. 2  

 

By default the input and relay interfaces are connected to the UHF processor, but 

can be connected to the TRANSIT compatible processor, see chapter 4. 

 

If connected to the UHF processor, the inputs can control the LED at the front of the 

reader to provide feedback and a relay for switching devices (for example doors or 

gates).  

 

The front LED need to be configured as Remote (see chapter 6.3.5) to control them 

by the input pins. Input1 controls the “UnLock” (UL) color of the LED and input 2 

controls the Not Authorized (NA) color of the LED. 

 

The relay is by default set to automatic mode. The relay is activated for every tag 

read and stays activated for the tag hold time (see chapter 6.3.4). If the automatic 

mode is switched off, the relay is operated by input 1. 

 

By default the inputs are at 5V level and are controlled by pulling them to ground. 

The input pins are short-circuit protected. 

 

If connected to the TRANSIT compatible processor, the function of the inputs can be 

used for other purposes. See corresponding TRANSIT firmware guide. 

 

 

Figure 16: CONN. 2 

Pin Function 

1 Input 1 / UL 

2 - 

3 - 

4 - 

5 - 

6 Ground 

7 Ground 

8 Input 2 / NA 

Table 5: General input connection 

 

Figure 17: CONN. 3 

Pin Function 

1 Relay NO 

2 - 

3 Relay NC 

4 Relay COM 

5 - 

Table 6: Relay connection 
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3.3.2 READER DISABLE 
The reader disable input is located in CONN. 2. The reading of the uPASS Target can 

be disabled with the RDIS input. This input is commonly used in combination with a 

sensor (e.g. inductive loop) that detects the presence of a person or vehicle. The 

RDIS is by default 5V can be controlled by pulling it to ground (pin is short-circuit 

protected). When the RDIS input is 0V the reader is disabled. 

 

This function works in both Normal mode and TRANSIT compatible mode. 

 

 

Figure 18: CONN. 2 

Pin Function 

1 - 

2 - 

3 - 

4 - 

5 RDIS 

6 Ground 

7 Ground 

8 - 

Table 7: Reader disable connection 

 

3.3.3 EXTERNAL ANTENNA 
It is possible to connect an external Nedap UHF antenna to the uPASS Target reader. 

The external UHF antenna can be used in 3 possible configurations (see chapter 

6.4.6): 

1. Internal only. This mode is used if no external antenna is connected. 

2. External only. This mode is used if the uPASS reader cannot be mounted at 

the location but an antenna can, the reader can be place at another location 

and connect to the antenna. 

3. Internal and external. The antennas can be installed in two separate 

locations (for in/out lane separation). 

 

The external antenna is located at Ext. Ant. connection. The connection is a reverse 

polarized TNC connector. 

 

Only Nedap antennas shall be connected. 
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4 TRANSIT COMPATIBLE MODE 

The uPASS Target has a TRANSIT compatible processor. This processor is capable of 

running the TRANSIT software (e.g. P61, P81 and Q70). To select this mode the 

dipswitch SW1-1 (located near the USB port see chapter 3.2.4) must be switched ON. 

 

If the TRANSIT compatible mode is selected, most inputs and outputs are switched to 

the TRANSIT processor. This means that configuration of the UHF processor (e.g. LED 

operation, frequency setting and TRANSIT switch settings) is not possible anymore 

via RS-485, RS-422, USB or TCP/IP Channel 1. Configuration via TCP/IP Channel 2 is 

still possible. 

 

Make sure the serial setting of the Ethernet are correctly configured to work in the 

TRANSIT compatible mode. This can differ based on firmware version and DIP-switch 

settings (see the TRANSIT firmware documentation). The serial settings of the 

Ethernet can be changed with the web interface: 

 Open the browser and go to the readers IP address 

 Fill in the username and password (by default both blank) 

 Open “Channel 1” - “Serial Settings”  

 Check if the “Port Settings” match the reader serials settings (as for USB or RS-

422/RS-485) 

  Click OK and Apply Settings 

 

The only UHF tags that are read in TRANSIT compatible mode are Nedap UHF XS and 

Nedap UHF EM4102 tags. 

 

4.1 TOOLING 
The TRANSIT compatible mode requires the tooling used for the TRANSIT readers.  

 

To update the TRANSIT compatible processor, the “PICload” tool can be used. 

 

To test if a P81 firmware is working correctly “P81Test” can be used. 

 

These tools can be downloaded from https://portal.nedapidentification.com. 

 

4.2 SWITCH SETTINGS 
The TRANSIT software is configured by hardware DIP switches (see corresponding 

firmware documentation of the TRANSIT). These DIP switches are not available on 

the uPASS Target and are therefore emulated. The uPASS reader has to be 

configured to the right settings. This can be done with the UHFTOOL, see chapter 

6.3.3 (make sure the SW1-1 is OFF while configuring). 

 

 

 

  

https://portal.nedapidentification.com/
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5 UHF FREQUENCIES 

Radio Regulations 

The uPASS Target reader is available in two regions.  

 The uPASS Target Region 1 operates in the 865 – 868 MHz (ISM) band. 

 The uPASS Target Region 2 operates in the 902 – 928 MHz (ISM) band. 

 

Regulations in this band are not standardized world-wide. Generally the regulations 

can be divided into several regions. When ordering an uPASS Target reader this 

region must be specified (see UHF How To Order Guide). 

 

Per region a specific frequency band is available. This frequency band is divided into 

frequency channels. If local radio regulations require frequency hopping (FHSS), 

then the uPASS Target automatically selects and uses the available channels. 

 

Frequency channel selection 

If no frequency hopping is required, it is still advised to use frequency hopping. 

Frequency hopping is less sensitive for interferences. 

 

Selecting a fixed frequency can be realized with the UHFTOOL (see chapter 6.4.4). 

This is only possible if frequency hopping is not required. Select a free frequency 

channel to achieve the best performance and to avoid interference from other 

readers or equipment. 
  



UPASS TARGET | INSTALLATION GUIDE 
Reader Configuration 

 21/36 

6 READER CONFIGURATION 

The uPASS Target reader settings can be configured easily using the UHFTOOL 

software. The UHFTOOL requires a Microsoft Windows installation to run. Software 

developers can find the communication protocol description in the firmware guide. 

 

6.1 UHFTOOL SOFTWARE 

 

Figure 19: UHFTOOL software 

 

6.2 CONNECTING 
To connect to the uPASS reader click File -> Connect, press F2 or click on the 

connect button. This opens the connect panel where the connection settings can be 

configured. In this panel, the COM port can be selected or the IP address and port 

can be typed and the baud rate can be selected (default 115200). Click OK to 

connect. 

 

 

Figure 20: Connect panel 
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6.3 SETTINGS 
Click 'View' -> 'Show config sidebar' or press F11 to show the configuration sidebar. 

In the sidebar the configuration categories are shown. Expand or collapse the setting 

panels by clicking on it. 

 

 

Figure 21: UHFTOOL sidebar 

 

6.3.1 CHANGE BAUD RATE 
To change the baud rate the “Setup baudrate” window must be opened. This is done 

by clicking on “Option” -> “Setup baudrate”. Select the new baud rate and click OK. 
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6.3.2 READ DATA 
Configure which tags should be selected, how to access these tags and what data 

should be read from these tags. 

 By default the reader is configured to select ANY TAG and read its EPC 

number. 

 Select Nedap to read only Nedap tags. 

 Nedap DUAL-ID enables the uPASS to search for Nedap vehicle-id tags. 

When a vehicle-id tag is found, the uPASS searches for driver-id tags. 

 Custom enables to specify custom select criteria and the data to be read. 

 

Example 1 

Read only Nedap UHF tags: 

 

 

Figure 22: Read data example 1 

 

Example 2 

Read only NXP UCODE tags (TID starts with E2006) and read 4 words (1 word is 16 

bits) from user memory. 

 

 

Figure 23: Read data example 2 
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6.3.3 DECODE NEDAP XS 
Enable decode Nedap XS formatted tags. 

 

 

Figure 24: Output settings 

 

By default the data on Nedap XS formatted tags is transmitted to the TRANSIT 

compatible processor and the Nedap antenna modulation interface. In this case the 

uPASS will not perform any decoding. 

 

Enable the 'decode Nedap XS' option to decode the Nedap XS tag data and output 

its plain tag-number. In this case the TRANSIT compatible processor and the antenna 

modulation interface are not used. Additionally this function can be used to verify or 

output the customer code. 

 

Enable the option 'Allow other tag formats' when the reader should also support 

other formatted tags, such as Nedap UHF Wiegand formatted tags and others. 

 

See the uPASS decode Nedap XS Application Note for more information. 

 

TRANSIT compatible mode 

When using the TRANSIT compatible mode ensure that the 'decode Nedap XS' option 

is disabled. Select the DIP switch emulator settings with the checkboxes 1-7 (see 

TRANSIT firmware guide). The box “TRANSIT compatible mode” indicates if TRANSIT 

compatible mode is currently enabled, see chapter 4.  
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6.3.4 RELAY / TIMING 
Configure relay output and timing parameters. 

 

 

Figure 25: Relay / timing settings 

 

Enable 'Automatic relay activation' to activate the relay upon identification. When 

disabled, the relay can only be activated manually trough a serial command or input 

signal. 

 

The 'Tag hold time' setting is the minimum time a tag is remembered. During this 

time the front cover LED indicates a tag read and the relay is switched. 

 

The 'Vehicle hold time' setting is the time, after a vehicle-id tag has been found, for 

which the reader will search for driver-id tags. This setting is only used in the Nedap 

DUAL-ID mode (see chapter 6.3.1). 

 

The (random) RF off time parameter can be used to enable multiple Nedap uPASS 

readers on the same frequency without then interfering with each other. By default 

this setting is on, it is recommended to keep this setting on. 
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6.3.5 LED CONTROL 
Automatic mode: 

Default the uPASS reader controls the LED automatically. 

With “Color UL” the tag read color can be configured. With “Color NA” the color, that 

indicates that the reader is waiting, can be configured. These settings will also be 

used in TRANSIT compatible mode. 

 

 

Figure 26: LED automatic 

 

Remote control: 

The LED can be controlled remotely by a connected access control system. The UL 

and NA digital inputs (see chapter 3.3.1) determine the color of the LED. 

 

 

Figure 27: LED remote control 

 

Direct control: 

With direct control, the color can be controlled through serial connection. The color 

and brightness are directly set via the serial command (see firmware guide). 

 

 

Figure 28: LED direct control 
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6.4 EXPERT SETTINGS 
Click 'Options' -> 'Usermode' -> 'Expert' to show additional configuration settings for 

advanced users. 

 

6.4.1 OUTPUT 
Configure communication output settings. 

 

Figure 29: Output settings 

 

Select 'Enable serial id-events' to enable the serial output upon identification. Only 

disable the serial id-events to optimize the identification speed when using the 

Wiegand, Magstripe interface or the TRANSIT compatible processor. 

 

When 'Fast repeat serial id-events' is selected (default) the serial output is repeated 

upon every identification while the tag is in the read range. When this option is 

disabled, the message is transmitted at the same rate as the Wiegand or Magstripe 

interface. 

This setting has no effect when using the Wiegand, Magstripe or Nedap antenna 

interface. 

 

By default the 'Repeat using hold-time interval' is disabled. The messages on the 

Wiegand or Magstripe will only be send once when a tag enters the read range. If 

enabled, the messages are repeated every hold-time (configured in chapter 6.3.4) 

while the tag is within the read range. 

The setting has no effect on the Nedap antenna interface and may have effect on 

the serial interface (depending on the 'Fast repeat serial id-events' setting). 

 

'Enable vehicle id-events' allows enabling or disabling the id-event messages for 

vehicle-ids. This may be useful in combination with the Nedap DUAL-ID mode and 

an access control panel that does not support the dual-id feature.  

 

'Main comm interface' is used to select the main serial communication interface. The 

choice is between RS-422 (and RS-485) or TCP/IP. Wiegand en Magstripe will still 

work. 
  

Note 

If the 'Main comm interface' 

is changed, the UHFTOOL 

may lose connection. 

 

Note 

USB always overrules the 

‘main serial communication’ 

setting. 
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6.4.2 OUTPUT MESSAGE FORMAT 
Configure output message format. 

 

 

Figure 30: Output message format 

 

The output message format is configurable: 

[<PREF>] [<80 AC PH RSSI>] [<EL>] [<EPC>] [<DL>] [<DATA>] [<SUFF>] C
R LF 

 

6.4.3 EXTRA OUTPUT 
Optionally enable Wiegand or Magstripe output for tags that are not programmed by 

Nedap in a Wiegand, Magstripe or Nedap-XS format. 

 

See uPASS Wiegand output Application Note for more information. 

 

6.4.4 FREQUENCY 
These settings show the reader's operating frequency region. 

Select a frequency channel (within the available frequency band) for systems that do 

not require frequency hopping. 

 

With 'Power on' the reader can be enabled or disabled. 

 

 

Figure 31: Frequency 

  

Note 

When the output message 

format is changed, 

identified tags may no 

longer be shown in the 

UHFTOOL. 
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6.4.5 READ RANGE 
With 'Read range' the tag read distance can be configured, this can be useful to 

optimize lane separation. With the 'Antenna output power' the power of the antenna 

is configured. The antenna output power controls the distance in which the tag is 

activated. With the 'RSSI threshold' the tags are activated and read, but filtered by 

the firmware based on their signal strength (RSSI). 

 

 

Figure 32: Read range 

 

6.4.6 ANTENNA 
Antenna settings can be changed in the Antenna panel. With the “antenna select” 

setting the mode of antenna operation can be selected. 

 

For the Internal and External antenna the output power can be configured. This is the 

same setting as the “Antenna output power” from the read range (see chapter 6.4.5). 

 

With “Dwell time” the maximum ON time of the antenna is configured. The maximum 

ON time is the time in milliseconds that the antenna is activated during a tag 

identification round. If configured to zero there is no maximum ON time. 

 

The “Inventory cycles” are the amount of cycles the reader tries to find all tags 

within a tag identification round. The uPASS Target reader can find up to 4 tags every 

cycle. 

 

If “Dwell time” and “Inventory cycles” are both set, the time which is the shortest 

will be used. Both settings may not be configured to zero. 

 

 

Figure 33: Antenna 
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7 FIRMWARE UPDATE 

The firmware of the uPASS Target (UHF processor) can be updated with the 

“uPassTarget Updater”. This tool is part of the UHFTOOL and can be downloaded 

from the portal https://portal.nedapidentification.com. It is designed for Microsoft 

Windows and requires Java 7 (or higher) to run. This can be downloaded from 

http://www.java.com/download/. The latest firmware version can be downloaded 

from the portal https://portal.nedapidentification.com/. 

 

For updating the TRANSIT compatible processor see chapter 4.1. 

 

After installation a Start Menu entry will be created to start the uPassTarget Updater. 

 

 

Figure 34: uPassTarget Updater 

 

Connecting 

To connect to a uPass Target, select a COM port and baud rate (default 115200) from 

the dropdown box or type an IP address and port (default 10002).  

 

For a successful connection via RS-422 / RS-485 a baud rate of 9600 must be 

supported. This means the PC (running the updater) and the transport medium 

(cables and converters) must at least support a baud rate of 9600. The updater 

automatically tries a faster baud rate (115200) for a faster upload. If this fails it will 

fall back on 9600 baud.  

Although the RS-485 can be used in a bus. It is not possible to update uPASS Target 

reader when connected in a bus. For updating a point-to-point connection is needed. 

 

Uploading 

Uploading can be done by selecting the firmware via the Browse dialog or typing the 

location directly. If the selected file is found and is correct, the Upload button 

becomes available. Clicking on this button starts the update process. During the 

update the progress bar indicates the current progress. If the progress bar reaches 

100% the firmware update is done and the reader will start the new firmware.  

https://portal.nedapidentification.com/
http://www.java.com/download/
https://portal.nedapidentification.com/
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A TECHNICAL SPECIFICATIONS 

Item Specification Remark 

Dimensions 286mm  x 285mm x 78mm 

11.26in x 11.22in x 3.01in 

Length x width x height 

Weight 3.5 kg (7.72 lbs.)  

Cover material UL94 ABS cover (RAL7016)  

Chassis material Aluminum (RAL9006)  

Protection class EN IEC 60529 + A1 (IP66)  

Operational 

temperature 

-30 °C … +60 °C 

-22 °F … +140 °F 

 

Relative humidity 10 .. 93 % non-condensing  

Identification 

range 

Up to 10 meters (33 feet) (line-of-sight) With passive Nedap UHF tags 

Power supply 12 … 24VDC ±10% power supply 

Power over Ethernet plus (IEEE 802.3at) 

 

Current 

consumption 

1.50A @ 12VDC 

0.75A @ 24VDC 

 

Inputs 2 digital input for LED control 

1 digital input for reader disable1 TNC 

Nedap UHF antenna 

Active low inputs (0V – 5V) 

Active low input (0V – 5V) 

Output Wiegand, Magstripe (clock & data), Nedap 

EM4102, Nedap CR/LF 

Other possible in TRANSIT compatible 

mode, see TRANSIT firmware guides 

Relay 1 relay (NO, common, NC) 24VDC 2A  

Interfaces RS-422, RS-485, Ethernet and USB  

Air interface ISO18000-6C  

Polarization Circular  

Operating 

frequency 

Country Frequency Technique Power 

ETSI 865.7 - 867.5 MHz FHSS 4ch 2W ERP 

FCC 902.7 - 927.2 MHz FHSS 50ch 1W cond, ≤6dBi gain 

Brazil 915.5 - 927.5 MHz FHSS 41ch 1W cond, ≤6dBi gain 

China 920.6 - 924.4 MHz FHSS 20ch 2W ERP 

Australia 920.7 - 925.2 MHz FHSS 10ch 4W EIRP 

Israel 915.1 - 916.9 MHz DRM 4ch 2W EIRP 

South-Korea 917.3 - 920.3 MHz FHSS 6ch 4W EIRP 

New Zealand 922.5 - 926.0 MHz FHSS 8ch 4W EIRP 

Japan 916.8 - 920.4 MHz DRM 4ch 1W cond, ≤6dBi gain 

Malaysia 919.8 - 922.2 MHz DRM 5ch 2W ERP 

Taiwan 922.6 - 927.4 MHz FHSS 9ch 1W cond, ≤6dBi gain 

Vietnam 866.3 – 867.5 MHz DRM 3ch 2W ERP 

Philippines 918.5 - 919.5 MHz DRM 3ch 0.5W ERP 

Russia 866.3 - 867.6 MHz  DRM 3ch 2W ERP 
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Immunity EN 50364 

EN62369-1 

EN301 489-1 V1.9.2 

EN 301 489-3 V1.6.1 

EN 55022 

EN 61000-6-2 

EN 61000-6-3 +A1 

 

Safety EN 60950-1  

Emission EN 302 208-1 v1.4.1 

EN 302 208-2 v1.4.1 

ERC REC 70-03 

FCC 47 CFR part 15 subpart C Section 

15.247 

Industry Canada RSS-247 

 

Shock IEC 68-2-27 Ea 50 G, 6 ms, 10x3 dir 

Bump IEC 68-2-29 Eb 25 G, 6ms, 1000x3 dir 

Random vibration EN 50155 5 – 150Hz, 5 G, 20 sweeps x 3 dir 

 

  



UPASS TARGET | INSTALLATION GUIDE 
Part Numbers 

 33/36 

B PART NUMBERS 

Readers 

 

Nedap uPASS Target Region 1 (EUR 865-868 

MHz) 
9217363 

 

Nedap uPASS Target Region 2 - 3 (USA 902-

928 MHz) 
9217371 

 

Antennas 

 

Nedap uPASS Target Region 1 (EUR 865-868 

MHz) 
9219021 

 

Nedap uPASS Target Region 2 - 3 (USA 902-

928 MHz) 
9219048 

 

Mounting 

 

Wall Mounting Bracket 9984364 

 

Pole Mounting Set 5626595 

 

Weather Protection Hood 5762804 
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C FCC / IC STATEMENT 

FCC ID:  CGDUPASSTAR 

IC: 1444A-UPASSTAR 

 

Compliance statements (part15.19) 

This device complies with part 15 of the FCC Rules and to RSS-247 of Industry 

Canada. Operation is subject to the following two conditions: 

(1) this device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that 

may cause undesired operation. 

 

Cet appareil se conforme aux normes CNR-247 exemptés de licence du Industriel 

Canada. L'opération est soumise aux deux conditions suivantes: 

(1) cet appareil ne doit causer aucune interférence, et 

(2) cet appareil doit accepter n'importe quelle interférence, y inclus interférence qui 

peut causer une opération non pas voulu de cet appareil. 

 

Warning (part15.21) 

Changes or modifications not expressly approved by party responsible for 

compliance could void the user’s authority to operate the equipment. 

 

RF Exposure (OET Bulletin 65) 

To comply with FCC RF exposure requirements for mobile transmitting devices, this 

transmitter should only be used or installed at locations where there is at least 20cm 

separation distance between the antenna and all persons. 

 

Information to the User (Part 15.105(b)) 

Note: This equipment has been tested and found to comply with the limits for a class 

B digital devices, pursuant to part 15 of the FCC Rules. These limits are designed to 

provide reasonable protection against harmful interference in a residential 

installation. This equipment generates, uses and can radiate radio frequent energy 

and, if not installed and used in accordance with the instructions, may cause harmful 

interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does not 

cause harmful interference to radio or television reception, which can be determine 

by turning the equipment off and on, the user is encouraged to try to correct the 

interference by one or more of the following measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver. 

 Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected. 

 Consult the dealer or an experienced radio/TV technician for help. 

 

UL 

This equipment is intended to be powered from a limited power supply that is listed as ALVY 

(UL294) or APHV (UL603). 

UL294 Classifications: Destructive Attack: Level 1 

    Line Security: Level 1 

    Endurance: Level 4 

    Standby Power: Level 1 
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D DISCLAIMER 

This information is furnished for guidance, and with no guarantee as to its accuracy 

or completeness; its publication conveys no license under any patent or other right, 

nor does the publisher assume liability for any consequence of its use; specifica-

tions and availability of goods mentioned in it are subject to change without notice; 

it is not to be reproduced in any way, in whole or in part, without the written consent 

of the publisher. 
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E DOCUMENT REVISION 

Version Date Comment 

1.05 2016-03-16  Changed South-Korean frequency setting and 

number of channels. 

 Changed Vietnam frequency setting and number of 

channels. 

 Updated some country names in the frequency 

overview. 

1.04 2016-03-01  Changed FCC reference:  RSS210, CNR210 to RSS-

247, CNR-247. 

 FCC Part15.106 changed to FCC Part15.105 

1.03 2016-02-18  Added inch measurements to dimensions drawings 

 Added image of the Ethernet connector 

 Corrected text that mini USB and TNC aren’t supplied 

 Added external antenna setting reference to tooling 

chapter. 

 Used correct name for the TRANSIT compatible 

processor update tool 

1.02 2016-01-20  Added Russian frequencies 

 Added FCC/IC numbers 

 Added Antenna part numbers 

 Added Antenna images (part numbers) 

 Added mounting images (part numbers) 

 Added information when to place the weather 

protection hood 

 Removed the resistor that was placed instead of the 

120KHz antenna in the Nedap antenna interface. 

1.01 2015-12-08  Initial version 

 




